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1. Introduction

1.1 Reason for these instructions

These instructions explain to the user of the AP Vision Theme Designer software program
how the use this Windows program.

1.2 About the AP Vision Theme Designer software

The APD Vision Theme Designer software program is designed to make it possible to create
custom colour themes for the 2020 Vision handset with colour screen of the AP Inspiration
Vision line of ECCR’s (Electronically controlled closed circuit rebreathers), as released in
2015.

This software cannot be used to create custom screen themes for the older monochrome
Vision handsets.

1.3 Copyright and Applicable Law

These instructions are copyrighted, all rights reserved. It may not, in whole or in part, be
copied, photocopied, reproduced, translated, or reduced to any electronic medium (including
the Internet) or machine-readable form without prior consent in writing from AP Diving.

All products are sold on the strict understanding that only English Law applies in cases of
warranty claims and product liability, regardless of where the equipment is purchased or
used. Should a claim be made then the venue for this would be in Truro, England.

© 2017 AP Diving.
AP Vision Theme Designer software and User Manual
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2. Creating a new colour theme

1) Select an existing colour theme. Select the one with the closest resemblance to the
new one you want to create.
In the example below we choose existing AP theme “AP Day-Glo” to start with:

( @ AP Day-Glo - AP Vision Theme Designer | e S
i File Edit Tools Help
ENR N N L - AR
Theme Name
AP Colour Blind (30 0.70 4 () (3 ()
47 Moncchrome Hck 0.690.690.70
AP Monochrome Green y 00— 049 [CIFEET 25m
AP Monochrome White 1 DESIGN YOURTHEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR 999 nsT 2.8m
AP Smart S -
Bl secoond
General Foreground Text 1304 O
I vaming Background —_
[ wemngTec ! 1.281.281.31
Setpoint, Icons & Frames _— ss:17 CIFEEE 71.im
Battery Master Frame
o 0 69 0 69 O 7 0 O 38 382 29.3m
B sattery Block Low . . "
Scrubber Normal . -
B s ton 0:49 DIL1 Air 2.8m
Information & Icons Background
B ~formation &Icons Foreground 9 9 9 o 2 8
B celiError Background NST . m CELL WARNING
Cell Error Text
Deco NST Text O
Deco TTS Text
I MenultemText N AM A An A A
T Dhentiabe 0.690.690.70
SET POINT SWITCH
More Colours mom‘i
CELL CHECK
0.270o1 1.29
Ready NUM

2) Select the “Save as....” Button in the “File” dropdown menu in the upper left corner of
the screen:

(@ AP Day-Glo - AP Vision Theme Designer =|E
© y g |
i[[File | Edit Tools Help
J 0 New cti-N | @ @
1J‘ Open... Ctrl+0
| ﬁ (3 0.70.4 () (73 (1)
I Save As... P ——
1 e 0.690.690.70

“\Users\...\Tino3.thm
2 C:\Users\...\tino2.thm o:49 CIEWEETE] 2sm
3 C:\Users\...\Tinol.thm DESIGN YOUR THEME 2 GENERATE UPLOAD FILE 3 UPLOAD USING AP COMMUNICATOR 999 nst 2.8m
4 APTheme_Smart_2.thm
Background
Exit General Foreground Text
1.304 O
B warning Background Wi
[ vamegex (51 0.70 « (i) () (51) 1.281.281.31
Setpont, lcons & Frames - O se:17 NI 7iim
Battery Master Frame
| e 0 69 0 69 0 7 0 O 387 382 25.3m
B sattery Block Low . " .
Scrubber Normal . E
i 0:49 DIL1 Air 2.8m
Information & Icons Background
B 1~formation & Icons Foreground 9 9 9 2 8
B cellError Background NST . m CELL WARNING
Cell Error Text
I DeconsTText O
Deco TTS Text
I venu Ttem Text YA AYAYAATAY N
O oientiobel 0.690.690.70
SET POINT SWITCH
More Colours (310.70 4 () 3 ()
CELL CHECK
0.27o1 1.29
Ready CAP NUM
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3) Alternatively you can select the “Save as...” button in the icon bar in the top left
corner of the screen:

( @ AP Day-Glo - AP Vision Theme Designer = | B )
i File Edit Tools
ERRN=A 1 | [EACK
Theme Name | il Save As
AP Colour Bli Save the active document with a new mo 70 4 [ — G(:l
AP Day-Glo = z
40 Monochrome Black 0.690.690.70
AP Monochrome Green 049 [CIEEET] 25m
22 :"°"°°“’°mew"“e 1 DESIGN YOUR THEME 2 GENERATE UPLOAD FILE 3 UPLOAD USING AP COMMUNICATOR 000 re 2.8m
mart S ~ o
Bl secoound
General Foreground Text @ 1.304 oM
I \aring Background i
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Battery Master Frame
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B sattery Block Low . " "
Scrubber Normal . - (30 1.30.4 () C3 (1)
[ 0:49 DIL1 Air 2.8m 8 1.304 (o) C3CW.
T nformatin  1cons Backround 0% 1.30 1.29
B tformation & Icons Foreground 9 9 9 NST 2 8 m [c1]c2]
I cel Error Background .
Cell Error Text CELL WARNING
Deco NST Text O
PSS (31 0.70.4 (m—) (3 (D
- Menu Item Text Y TYYyY Y S ors
T owentase 0.690.690.70
SET POINT SWITCH
More Colours 68 0.704 (o) CH(ED
CELL CHECK
0.27o1 1.29
Save the active document with a new name NUM

4) A pop-up screen will now appear which allows you to specify the location of your new
theme file. We suggest you leave the suggested file directory unchanged, being “My
Documents > AP - AP Vision Theme Files”.

(@ AP Day-Go - AP Vision Theme Designer BEIEN)
i File Edit Tools Help

HR = R %1 0@
Theme Name /
AP Colour Blind

AP Day-Glo
AP Monochrome Black

(1 0.70 4 (e—) (3 (1D
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AP Monochrome Green
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AP Monochrome White 1 DESIGN © Save As E R o 2.8
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Bl secoond (OO [0« AP » AP Vision Theme Files » « [4 ][ Search AP Vision Theme Fies P
GeneralForg | Organize v Newfolder =y @ B 1.304 o@
- Warning Bac =
[ | WamingTe Ee—— Name Date modified Type 128 128 131
[T setpoint, X B Desktop Upload Files 6-6-201510:34 File folder sg:17 (NS 7i.im
Battery Mas| 18 Downloads
B sattery i % Recent Places = 38ms 38.2 25.3m
B sttery Biod]
Scrubber No| [ (4 Libraries
B scubber Lof = Documents
Information & Music
Bl formation &) Pictures
B celError Bl B Videos
[ celErorme CELL WARNING
Deco NST Te +& Homegroup - it 5
Deco TTSTq File name: | 00 -
I venuttemT] - —————
ave as type: | AP Vision Theme files (*.thm -
it | R e I 0.69 0.69 0.70

i SET POINT SWITCH

More Colours (& 0.704 () 3 (71

0.690.69 0.70

CELL CHECK
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Ready NUM
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5) Change the “file name” field to the name you chose for your new theme file.
In the example below we choose the new file name to be “MyNewTheme1.thm”.

/ﬁ AP Smart - AP Vision Theme Designer [cal = |
i File Edit Tools Help
ENRN= 1| L AN
Theme Name
AP Colour Blind (30.70 4 ( mm—) 3 (5
AP Day-Glo N S SN T T
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Ready NUM

6) By pressing the “Save” button you have now created a new theme and associated
theme file. Its name will now show up in the list of themes in the column on the left of
the screen, and can be selected for further customization:

O | B |

@ MyNewThemeL.thm - AP Vision Theme Designer
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3. Customising your new colour theme

1) On the right side of the big screen depicting the currently selected screen for
customizing there is a row of 5 smaller screens. These are called “mimics” and they
represent all possible screen variations in the 2020 Vision colour handset, and as
such also represent all user-changeable fields:

( © MyNewThemel.thm - AP Vision Theme Designer S | B S
i File Edit Tools Help
P Al #* 10
Theme Name /
AP Colour Blind (300.70 4 (m—) (3 (1D
AP Day-Glo
42 Monochrome ik 0.69 0.69 0.70
AP Monochrome Green y = —— 049 [CFHT] 25m
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2) On the left side of the big central screen you find a row containing ALL the types of
fields as used in the various screens of the 2020 Vision handset:

/e MyNewTheme1.thm - AP Vision Theme Designer o | B S
i File Edit Tools Help
R = W #1060
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3) To change a colour, first click on one of the 5 small mimics to make it the main focus
entry mimic (i.e. the large one in the centre), and as such the screen you want to
change. Here we select the “CELL WARNING” mimic in order to be able to change it:

( @ MyNewThemeL.thm - AP Vision Theme Designer [E=NEE
i File Edit Tools Help
ERRN=2 N | .1 0@
Theme Name /
(3 0.70 4 () 3 (D)
. o] g, 0.690.690.7
Green 049 [THIET] 28m
onochrome White 1 DESIGN YOUR THEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR 999 s
AP Smart 999 ns 2.8m
MyNewThemel Bl scoond
; General Foreground Text 1.304 o@
Warning Background B e —————
[ warwgron (] 1.30 « () () (1) 1.281.281.31
F Setpoint, Icons &Frames N ———— se:17 DIVEIT]  71im
Battery Master Frame O®
38ms 38.2 25.3m
e $1.0 1‘ 1.301.29 ¢
attery Block Low e
I scrubber Normal (0 1.30.4 (o) C ()
— s c1]c2 S 1 30 109
[T Information & Icons Backaround ‘1m 1.30 1.29
ey CELL WARNING -
[T celErorText
B DeconsTText
[T DecoTTsText (310.70 .4 () 3 ()
I venurtemText VAR AYAYAOYEE S Al
. 0.690.690.70
EEEEEEE SETPOINT SWITCH
More Colours... (B 0.70.4 () CI (1D
0.690.690.70
CELL CHECK
0.270. ¢ 2 1.29
Ready NUM

4) All of the colours that can be changed on the currently selected screen have
"lollipops" to indicate the items that can be changed. If you click on a lollipop it
highlights to show that it is the currently active one. The highlighting is visible by the
light grey shadow ring around the selected lollipop. The name of the item type (in this
case “General Foreground Text”) is also shown above the colour selection field:

(5] 1.30 « (i) () (1)

o 1501 1.30 1.29 g

CELL WARNING

\ General Foreground Text

More Colours...
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5) You can now select or create any colour, using the standard Windows colour
selection box. You can do that by either:
a. Picking a colour from the default 20 colours shown in the two rows in the

colour selection box, or
b. Using the "More Colours" button to drop down into custom choices, allowing
you to select just about any colour you want.

If you click on any of the 20 standard colours in the colour picker box, the item you

selected for change in the screen will change to that colour, allowing you to inspect
the effect of your colour selection.

CELL WARNING

General Foreground Text

More Colours...

6) If you press the “More Colours” button then you get three more options:
a. Choose a colour from the extended set of standard colours by selecting the
“Standard” tab:

QQ Q

Colors

Colors: w

More Colours...
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b. Or choose a custom colour, by selecting the “Custom” tab:

® oo
[

Colors:

A Select

Red: 255

Hue: [213)]

Saturation: 255 2 Green: 0 =

A

Luminence: 128 Blue: 255

Current

More Colours...

c. Or choose a colour by using the "dropper Select", which allows you to pick
any colour from any window open on your PC. So if you have an existing
image or photo you can simply pick up the colour from that image:

Qe @ Q@
Colors ﬂ

Standard | Custom

Colors:

Current

More Colours...
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7) If the colour you selected is not one of the 20 standard colours, it is also shown on
the right of the “More Colours” button:

CELL WARNING

General Foreground Text

More Colours...

8) When a new colour is selected, it is also displayed on all small mimics
instantaneously in the appropriate fields, to show the effect on all items and screens:

3 UPLOAD USING AP COMMUNICATOR

2 GENERATE UPLOAD FILE

M 150
CELL WARNING ae

CELL WARNING

General Foreground Text

More Colours... .
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In the example below we have changed:
a. the colour of the “Information & lcons Background” to purple, and
b. the colour of the “Information & Icons Foreground” to bright yellow.

Notice that all relevant fields in the 5 small mimics also get automatically updated:

9) You can now begin to make changes to your theme to adjust it to your liking.

ERR A" N W)

i File Edit Tools Help

1o

Theme Name

AP Colour Blind

AP Day-Glo

AP Monochrome Black
AP Monochrome Green
AP Monochrome White
AP Smart
MyNewThemel

1 DESIGN YOUR THEME

Background
General Foreground Text
Warning Background

Warning Text

Battery Master Frame
Battery Block Normal

||

[

||

—

777 setpoint, Icons &Frames
—

|

B sattery Block Low
I scrubber Normal

Il scubberLow
Information & Lcons Background

Information & Icons Foreground

& Bl 1304 (W

1.281.28 1.31 g

58:17

2 GENERATE UPLOAD FILE

DIL1  Air

3 UPLOAD USING AP COMMUNICATOR

71.1m

8.2 25.3m

039 0.69 0.70
o DILIIAR 0
999 nsT

B8 1304 @

1.281.281.31

58:17 DIEENNAIN 71.im
38ms 38.2 25.3m

B8 1.304 () (3 (1

0% 1.301.29

o162

1S
- &t . LWARNING
B oeconsTText O
[T DecoTsText 89 0.70 4 () () (D)
— oy o o erefe s 0.690.690.70
...-... SET POINT SWITCH
L] |

1B 0.70 4 (o) (3 (59

0.690.690.70

More Colours...

CELL CHECK
0.27 ¢ o2 1.29

10) If you click on any of the colour patches for the items in the legend (the column on the
left with all the field names), if that item is not present on the current active large
mimic, it will open the first mimic that does have that item and it will highlight that item
on the now active large mimic.

As an example let’s click on the colour patch next to the “Diluent Label”. The 5" small
mimic will now become the active one in the middle, as that is the only screen of the 5
mimics that carries the diluent label. The associated “lollipop” is already highlighted:

i File Edit Tools Help
PlGdA D &L
Theme Name
AP Colour Blind

[ 0.70.4 (o) (3 ()

e s’ t 0.690.69 0.70
AP Monochrome Black » | A ] . . .
AP Monochrome Green 0:49 |[DIESRNAIN 2.8m
AP Menochrome White 1 DESIGN YOUR THEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR 999 nst 2.8m
AP Smart - -
MyNewThemel Bl scoond
General Foreground Text B8 1304 CI@
I waming Background _—
[ wamnTex 3 Tl 0.70 4 (Comminem) (") (1) 1.281.281.31
Setpoint, Icons &Frames _—-s - s swtpt-r oeuo- — — 58:17 |DIEE AR 71.1m
Battery Master Frame
) 0 69 O 69 0 70 . 38 - 38.2 25.3m
B sottery Bock Low . . -
Scrubber Normal C E L L C H E C K
B scubber Low
B information & Icons Background 1.Vl
Information & Icons Foreground 0 2 7 ‘J 02 1 2 9
Cell Error Background = - D
Cell Error Text cELL WARNING
Deco NST Text
DecOjiSHext (B 0.70 4 () (3 (1)
- Menu Item Text Diluent Label YT Y Yy Y.
ivent Labe = 0.690.690.70
EEEEENE SETPOINTSWITCH

(B 0.70 4 (o) (3 (1)

0.690.690.70

More Colours...

CELL CHECK
027 ¢ 2 1.29
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11) WARNING A If you select a background/foreground pair that contains colours that
are too similar to each other and as such do not offer enough contrast to be properly
readable on the handset, the theme gets invalidated and you first need to modify one
of the colours to correct it. You CANNOT save themes that have colour conflicts.

In the example below we have chosen a wrong combination of background and
general foreground text colour. The conflicting colours are marked red, and notice a
warning text “Invalid Theme !!'” appears in the lower left corner:

© AP Smart - AP Vision Theme Designer B
i File Edit Tools Help
ERRN=AE WY ALK . AKX 3
Theme Name i
AP Colour Blind
AP Day-Glo
AP Monochrome Black
AP Monochrome Green
AP Menochrome White ESIGN YOUR THEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR
AP Smart
MyNewThemel Background 1t
General Foreground Text .
Warning Background
[ — m 0.70 4 () () (1)
Setpoint, Icons &Frames -
Battery Master Frame
Battery Block Normal 38 s 38'2
B sttery Block Low
Scrubber Normal
B scubberLow
Information & Icons Background
B ~formation & Lcons Foreground A 02
Cell Error Background CELL WARNING
Cell Error Text
Deco NST Text
Deco TTS Text
I venu ttemText General Foreground Text
B oiventLabel
Invalid Theme 1 EEEEEEN
e L] [ |
More Colours...
Ready NUM

12) As long as you have one or more colour conflicts, you will not be able to save the
theme, or create a new theme with that conflicting colour combination. The “save”
and “save as...” functions and buttons are now greyed out and cannot be selected:

@ AP Smart - AP Vision Theme Designer o B S

ctri=N h

i[File | Edit Tools Help

2 C\Users\..\Tino3.thm

3 C:\Users\...\tino2.thm 2 GENERATE UPLOAD FILE 3 UPLOAD USING AP COMMUNICATOR

4 C:\Users\...\Tinol.thm

Exit

"
["B ™ Warning Background
Vg Tt 51 0.70 « (o) () ()
Setpoint, Icons & Frames -
Battery Master Frame
Battery Block Normal
Battery Block Low
Scrubber Normal
Scrubber Low

Information & Icons Background

Information &Icons Foreground ‘J 02 [c1]c2]
Cell Error Background
CELL WARNING

Cell Error Text
Deco NST Text
Deco TTS Text
Menu Ttem Text
Diluent Label

Invalid Theme !!! - . . . . - .
L] ]

General Foreground Text

RN NN
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@ AP Smart - AP Vision Theme Designer

o5 S

i File Edit Tools Help

GG A AL 1.0

AP Mdllochrome
ochrome

AP Mgnochrome 1 DESIGN YOUR THEME
AP art
My[wThemel Background m

General Foreground Text 1t

Warning Background

Warning Text

Setpoint, Icons & Frames
Battery Master Frame

Battery Block Normal

Battery Block Low

Scrubber Normal

Scrubber Low

Information & Icons Background
Information & Icons Foreground
Cel Error Background

Cell Error Text

Deco NST Text

Deco TTS Text

Menu Ttem Text

RN (NN NEENAE A

Diluent Label

Invalid Theme !!!

and make adjustments to comple
theme

Ready

3 UPLOAD USING AP COMMUNICATOR

2 GENERATE UPLOAD FILE

38ms 38.2

CELL WARNING

(3 0.70 4 () ) (D

General Foreground Text

NUM

13) Once you have made your preferred changes and have solved all colour conflicts,
save the changes to your custom theme by either selecting the File > Save dialog:

© MyNewThemel.thm - AP Vision Theme Designer

:[ File | Edit Tools Help

Hd [ New Ctrl+N

{ [ZZ Open. Ctrl-0
a save Ctrl+s
i saveas..

1 C:\Users\...\MyNewThemel.thm
2 C:\Users\..\Tino3.thm

3 C:\Users\...\tino2.thm N YOUR THEME
4 C\Users\..\Tinol.thm
d
Exit oreground Text
[ Warning Background
Warning Text

Setpoint, Icons & Frames
Battery Master Frame

Battery Block Normal

Battery Block Low

Scrubber Normal

Scrubber Low

Information & Icons Background
Information & Icons Foreground
Cel Error Background

Cel Error Text

Deco NST Text

Deco TTS Text

Menu Ttem Text

Diuent Label

ERIN (NN |

2 GENERATE UPLOAD FILE

3 UPLOAD USING AP COMMUNICATOR

38ms 38.2

General Foreground Text

More Colours...

Save the active document
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Or by simply pressing the “Save” button in the icon bar:

@ MyNewThemel.thm - AP Vision Th gner =
i File Edit T
) G Y 1o
Theme Nan [ Save (Ctrl+S)
AP Colout Save the active document
AP Day-Glo
AP Monochrome Black
AP Monochrome Green
AP Monochrome White 1 DESIGN YOUR THEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR
AP Smart
MyNewThemel || MM sackorond
I General Foreground Text
I warning Background —
[ wamngTex (51 0.70 .« (o) (1) (i)
Setpoint, Icons & Frames _—nmmm
Battery Master Frame 38 38 2
Battery Block Normal i -
B settery Block Low
Scrubber Normal
B scubberow
Information & Icons Background
Bl 1formation & Icons Foreground ‘J 02
B cellError Background -
Cell Error Text
Deco NST Text
Deco TTS Text
I venu ttem Text General Foreground Text
B oiventLabel
Mo
Save the active document NUM

14) WARNING !\ You CANNOT make changes to the 6 default themes that AP
provides:

AP Colour Blind

AP Day-Glo

AP Monochrome Black

AP Monochrome Green

AP Monochrome White

AP Smart

~0 Q00T

These themes can be used as a starting point to make your own customizations,
resulting in a custom theme, but they cannot be changed themselves.
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4. Creating an upload file

1) Once you are done with all your changes and have saved them in custom themes,
you can create an upload file. This is the file that will be loaded later on into your
2020 Vision colour handset by using the APD Communicator program.

You start the creation of an upload file containing your new theme by selecting “Tools
- Generate Upload File” from the Tools menu in the upper left corner (on the right of
the File menu):

[ © MyNewTheme2.thm - AP Vision Theme Designer o | B S
i File Edit | Tools | Help —
EORN= Select Theme Directory
Theme Name | X%~ Generate Upload File
AP Colour Bli 1, Upload Using AP Communicator (3)0.70.4 () C3 (1D
AP Day-Glo
47 Monochrome iack 0.690.690.70
AP Monochrome Green 049 [CIFHT 2:5m
AP Monochrome White 1 DESIGN YOURTHEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR 999 nst 2.8m
AP Smart JIINS -
MyNewThemel Bl secoound
General For;g;nunddText m 1304 G@
I vwaring Backgroun: -
[ wamigTex (5] 0.70 « (i) (1) (1) 1.281.281.31
Setpoint, Icons &Frames _— sg:17 CIREENS 7iim
Battery Master Frame
Satery Sodetlornal O 6 9 0 69 O 7 O . 38 - 382 25-3"]
B sattery Block Low " . "
oot CELL CHECK
B scubbertow
Information & Icons Background
B ~formation & Icons Foreground 0 2 7 A 02 1 29
B celError Background . .
Cell Error Text CELL WARNING
Deco NST Text
Deco TTS Text
- Menu Item Text YTy YR re
Bl ouertioe 0.690.690.70
SET POINT SWITCH
More Colours R 0.704 Commmm) CH (D
CELL CHECK
0.27: ¢ 02 1.29
Generates a file ready for upload NUM.

2) Alternatively you can select the “Generate Upload File” button in the icon bar in the
top left corner of the screen (on the right of the “Redo” button):

'e MyNewTheme2.thm - AP Vision Theme Designer o | E [t |
i File Edit Tools Help
HRR = | o3 @
Theme Name / | ¢ Generate Upload File
AP Colour Blind Generates a ly for upload (300.704 () (3 (3D
AP Day-Glo f
L e £ L 0.690.690.7
AP Monochrome Green 049 [ITHT] 28m
AP Monochrome White 1 DESIGN YOURTHEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR 999 nst 2.8m
AP Smart -
MyNewThemel Bl sacoound
NewTheme2 General Foreground Text O N
- oo B 1.304
Warning Backgrounc _
[ wonnge (51 0.70 « () (1) (1) 1.281.28
Setpoint, Icons &Frames _— s58:17 CIREN 71.im
Battery Master Frame
e 0 69 0 69 0 7 0 . 38 i 38.2 25'3m
B settery Block Low - " .
Scrubber Normal C ELL C H EC K
B scrubber Low
Information & Icons Background
B +formation & Lcons Foreground 0 2 7 ‘J 02 1 2 9
B  cel Error Background . .
Cell Error Text CELL WARNING
Deco NST Text
Deco TTS Text
I venurtem Text YW WYY TS
[ - 0.690.69 0.70
SET POINT SWITCH
More Colours (& 0.704 (o) C3 (1D
CELL CHECK
0.27: ¢ 2 1.29
Generates a file ready for upload NUM
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3) A screen box called “Generate Upload File” will now appear. We suggest you leave
the suggested file directory unchanged, being “Documents - AP - AP Vision
Theme Files - Upload Files”.

In this screen you can select two themes to go into the upload file.

Each upload file can and must contain two themes: no more, no less.

If you select only one custom theme for upload, the other theme will automatically
default to AP’s default theme, called “AP Smart”.

Select the one or two themes you want to go into your upload file using the two
dropdown selection boxes:

i File Edit Tools Help

O Al * 1 0@
Theme Name s
AP Colour Blind
AP Day-Glo ,’
AP Monochrome Black N\
AP Monochrome Green e
AP Monochrome White 1 DESIGN YOUR THEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR

(310.70 4 () 3 (1D

0690690 70

AP Smart
MyNewThemel Bl secoond
MyNewTheme2 General Foreground Text
Il  varing Background -_
[ mO_m 4 () (1) (1) 1.281.281.31
Setpoint, lcons & Frame e ss:17 PR 71.im
Battery Master F| Generate Upload File
B Gotiery Bocknor 38ms 38.2 25.3m
Upload File Directory
B cstiery lockLow C:\Users\Tino de Rik\Documents\AP AP Vision Theme Fies\Upload Files g
Scrubber Normal (3 1.30.4 (o) CO (D)
Bl scruberLon Custom1  MyNewThemel BEEAE 1 2N 1 2O
[ momatonale [[Geneate poadrie | 0% 1.301.29
Bl formation & I Custom2 | TEEIERY [c1]c2)
—p—— e
,_ Cell Error Text AP Day-Glo CELL WARN ING
AP Monochrome Black
Deco NST Text AP Monochrome White
-
DecoTTS Text —‘QP»T;’A"%?Z.';’SE oo (0.7 4 () (3 (1D
- Menu Item Text
B DientLabel 069 069 0.70

SET POINT SWITCH

(310.70 4 () 3 (i)
0.690.690.70
CELL CHECK
0.27: ¢ 2 1.29

Colours

4) Now press the “Generate Upload File” button to actually create the upload file:

© MyNewTheme2.thm - AP Vision Theme Designer =68 %
i File Edit Tools Help
N5 Ad) *| 1o
Theme Name /
AP Colour Blind S (300.70 4 (" m—) 3 (5
AP Day-Glo , 1
AP Monochrome Black 2 O el 069 069 070
AP Monochrome Green 49 8
2§ 2"°“°‘“’°'“E White 1 DESIGN YOUR THEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR
mart
MyNewThemel Bl ecoound
MyNewTheme2 General Foreground Text @, 1304 O
I  varming Background e A
[ wWamingren (51 0.70 « (i) (1) () 1.281.281.31
Setpoint, Icons & Frames e se:17 PN 711m
Battery Master Fr| Generate Upload File
B oty Sockod 38ms 38.2 25.3m
Upload File Directory
Bl cetteryBockLo C:Users\Tino de Rik\Pocuments AP\AP Vison Theme Fies\Upload Fies |
Scrubber Normal ) 1.30.4 o) Y@
Bl scubber Low Custom 1 MyNewTheme1 1 01
[ omaton 0% 1.301.29
Bl omatonalc||  Costom2 | TS am
I celiError Backgr
,_ Cell Error Text CELL WARNING
Deco NST Text
Deco TTS Text N (310.70 4 (e—) 3 ()
- Menu Item Text v w>y>:rays—vs
Bl oo 0.690.690.70
SET POINT SWITCH
More Colours (@ 0.704 (=) C3 (1
CELL CHECK
0.27:. ¢ o2 1.29
Ready CAP| NUM S
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5) The filename for the upload file will be generated automatically. The file name has the
format “Colour Theme - <name of the first theme> - <name of the second
theme>.ccr”.

So in this example the name will be “Colour Theme — MyNewTheme1 —
MyNewTheme2.ccr”:

i File Edit Tools Help

ENRN A N N * 1 o@

Theme Name /
AP Colour Blind

AP Day-Glo ,’ f
AP Monochrome Black N e

(31 0.70 4 (" e—) (3 (i)

0.690.690.70

AP Monochrome Green 049 [EH 28m
2’; ’;’“’""‘h“’mﬁ White 1 DESIGN YOUR THEME 2 GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR 2.8m
mart -
MyNewThemel Bl cacoround
MyNewTheme2 General Foreground Text 1304 @
I varing Background e ——————.
Warning Text 1.28 1-28 1-31
Setpoint, Icons &Frame . RV DIL1  Air JERERTY
Battery Master Fr| Generate Upload File
I sattery Block Nor Upload File Creation X 38ms 38.2 25.3m
Bl sattery Block Low
Sarubber Normal @ Creeted file C:\Users\Tino de Rijk\Documents\AP\AP Vision Theme (3 1.30.4 () 3 (D
Saubberlon Files\Upload Files\Colour Theme - MyNewThemel - —_—
u y
Information & Ic MyNewTheme2.ccr for upload. ‘1.Q1‘ 1.30 1.29
Bl i~formation &Icof c1]c2]
[ celiError Backgro|
Cell Error Text CELL WARNING
B oeconsTText A
Deco TTS Text < (30.70 4 (—) (3 (1)
- Menu Item Text YT YWY Y Yo
. 0.690.690.70

SET POINT SWITCH

B 0.704 Commmm) O
0.690.690.70
CELL CHECK
0.27 1.29

More Colours
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5. Upload the file to your handset with AP Communicator

1) The file with your custom themes is now created and can be uploaded to the 2020
Vision colour handset. This is done with the use of the AP Communicator program.
Vision users will know this program already as it is used for many other functions:

a. Downloading log and dive profile files, either with:

a serial or USB cable connection,

the AP DiveStore stick, or
a Bluetooth connection (2020 Vision colour handset only).
b. Uploading firmware updates
c. Performing remote diagnostics.
The same program can now also be used to upload the colour theme files to your
colour handset.

AP Communicator can be automatically started from within the AP Theme Designer
program. This way creating and uploading theme files becomes one integrated
workflow.

'
WARNING A The version of AP Communicator needs to be 5.2.0.0 or higher.

2) Starting the AP Communicator program from within the AP Theme Designer program
is done as follows. Select the “Upload using AP Commmunicator” function from the
“Tools” menu:

@ MyNewTheme2.thm - AP Vision Theme Designer

oS S

i File Edit
A =2 |
Theme Name

AP Colour Bl
AP Day-Glo

AP Smart
MyNewThemel
MyNewTheme2

AP Monochrome Black
AP Monochrome Green
AP Monochrome White

Select Theme Directory
£ Generate Upload File
2, Upload Using AP Communicator

BTN (NETEEEEE N N

1 DESIGN YOUR THEME

Background

General Foreground Text
Warning Background

Warning Text

Setpoint, Icons & Frames
Battery Master Frame

Battery Block Normal

Battery Block Low

Scrubber Normal

Scrubber Low

Information & Icons Background
Information & Icons Foreground
Cell Error Background

Cell Error Text

Deco NST Text

Deco TTS Text

Menu Item Text

Diluent Label

2 GENERATE UPLOAD FILE

3 UPLOAD USING AP COMMUNICATOR

(5] 0.70 .« () () (1)

0.690.690.70 g

CELL CHECK

027 ¢« 02 1.29

(3 0.70 4 () (3 (i)

0.690.690.70

049 [ITHT] 28m
999 nst 2.8m

1304 G

1.281.28 1.31
58:17 CIREMNd 71.im
38ms 38.2 25.3m

CELL WARNING

0.690.690.70
SET POINT SWITCH

(300.70 4 () (3 (1)

0.690.690.70

CELL CHECK
0.270. ¢ 2 1.29

Upload Using AP Communicator
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3) Alternatively you can select the “AP Communicator” button in the icon bar in the top
left corner of the screen:

MyNewTheme2.thm - AP Vision Theme Designer
© Myl g

o

: File Edit Tools Help

PG A

*“LW

Theme Name
AP Colour Blind
AP Day-Glo

AP Smart
MyNewThemel

AP Monochrome Black
AP Monochrome Green
AP Monochrome White

T T T T

AP Communicator

£
Upload Using AP Communicator

-

DESIGN YOUR THEME

Background

General Foreground Text
Warning Background

Warning Text

Setpoint, Icons & Frames
Battery Master Frame

Battery Block Normal

Battery Block Low

Scrubber Normal

Scrubber Low

Information & Icons Background
Information & Icons Foreground
Cell Error Background

Cell Error Text

Deco NST Text

Deco TTS Text

Menu Ttem Text

Diluent Label

2 GENERATE UPLOAD FILE

027 ¢ 02 1.29

(] 0.70 « (i) (1) (1)

0.690.690.70 g

CELL CHECK

3 UPLOAD USING AP COMMUNICATOR

(310.70 4 () 3 (20

0.690.690.70

049 [T 23m
999 nst 2.8m

1304 Om

1.281.28 1.31
58:17 [IEEMNd 71.1m
38ms 38.2 25.3m

) () ()

1.301.29
cifc2
CELL WARNING

([ 0.704 (" —) (73 (5D

0.690.690.70
SET POINT SWITCH

(3 0.70.4 () 3 (1)

0.690.690.70

CELL CHECK
0.27: ¢ 2 1.29

Upload Using AP C

4) Either action will start up the AP Communicator program, which can then be used to

perform the actual upload to the 2020 Vision colour handset:

(@ MyNewTheme2.thm - AP Vision Theme Designer o|E8] %
i File Edit Tools Help
= N N # Lo P
Theme Name
AP Colour Blind (31 0.70 4 () (3 (5
AP Day-Glo
2 Manocome Back 0.690.690.70
AP Monochrome Green 049 [ITWIT] 28m
AP Menochrome White 1 DESIGN YOUR THEME GENERATEUPLOADFILE 3 UPLOAD USING AP COMMUNICATOR 999 nst 2.8m
AP Smart ~ - -
MyNewThemel Bl sacoound
MyNewTheme2 General Foreground Text 1304 om
I \aring Background >
[ womingText 1.281.281.31
Setpoint, Ic mes s:17 RN 7iim
—
AP Communicator 38ms 38.2 25.3m
Invalid Com Port (3 1.30 4 (—) (3 (39
CELL WARNING
Download Upload (31 0.70 4 () 3 (30
T setings Clock &  Divestore SET POINT SWITCH
B woie @& pb | 5D ersupa
More Colour (1 0.70.4 () 3 (iD
o 690.690.70
A e (?) CELL CHECK
‘ 0.27 ¢ o2 1.29
Ready NUM
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5) For configuring and using AP Communicator we refer to chapter 12 “PC Connection”
of the AP Inspiration Rebreather User Manual (revision 05/15 or higher).

Make sure to select the correct upload directory containing your custom theme files
within the AP Communicator program. By default this is “Documents > AP > AP
Vision Theme Files > Upload Files”:

, AP Communicator I (= 23 .r

7

Settings

— Com Port Selection

ICDM1 - Communications Port

— Download Directory
|n:: \Wsers\Tino de Rijk\D

— Upload Directory

— Language Selection

Deutsch
Frangais
Italiano

i, 0K i x_ Cancel ‘
‘ — 9

Now you can enjoy your own custom colour themes!
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